
1 Receiving Problem – eMOs 
not Received 

First use the request resend option in divisional administrator 
web login . If the eMOs are still not received, please forward the 
log and error log folders & RXD folder for analysis to CEPT, 
Mysore. 
 

2 eMOs not Transmitted and 
Zip File pending outside 
TXD1 folder  or  
eMOs not available for 
tracking 

Please check whether your office is available in the Registered 
Offices list of not. If not available then please do web 
registration and client registration. 
 
If available then please forward the following items to CEPT, 
Mysore.  
1. Latest Backup of eMO database. 
2. Latest Copy of TXD, LOG and ERROR LOG folders from eMO 
client folder. 
3. List of PNR numbers which were not transmitted. 
 

3 eMOs Transmitted but not 
available for tracking 

Check whether your office is available in the Registered Offices 
list of not. If not available then please do web registration and 
client registration. Registration Procedure 
 
1. Do the web registration using Hardward change (if possible) 
not possible ok get the correct userid and password. 
2. Run the emoResetRegistration exl file in emoclinet machine 
using script tool (it will reset the existing client registration).  
3. Try to register the emoclient using the user id and password. 
4. Ensure that the security certificate is registered already. 
 
If the above information where carried on properly the office 
will be registered. If it is registered it should appear in the emo 
website in registered offices list 
 
Then wait for a day. Still the emos are not available for tracking  
please forward the following items to CEPT, Mysore.,  
 
1. Backup of eMO database. 
2. Copy of TXD, LOG and ERROR LOG folders from eMO client 
folder. 
3. List of PNR numbers which were not transmitted. 
 

4 eMO is not available for 
reprinting 

Please check whether the pincode is available by searching in 
Tools-> eMOoffices. If not available run eMOOffices and 
eMOPincodes scripts available in with latest release. 
 

5 Office Pincode is not 
available 

Run eMOOffices and eMOPincodes scripts available in latest 
release. 
 

6 eMO redirected but not 
showing in tracking as 
redirected 

If you are unable to redirect the eMO then please send the eMO 
database backup and TXD  folder to CEPT intimating PNR  
details. 
 
 



7 Paid data not updated in 
Central Server 

Use the disaster recovery option available in new version (Latest 
version) to update paid information.   
 

8 While running eMO 
Communication error is 
coming “Application failed 
to initialize properly” 

The .net framework might have been corrupted.  Uninstall and 
reinstall .net framework. 
 

9 Error while printing eMO – 
Booking eMO is not 
available 

Click on MO Details button in Tools ->Printing of eMOs and 
select the PNR Number to be printed 
 

10 Error in Communication 
Server encountered an 
internal error. To get more 
info turn on customErrors in 
the server's config file." 
 

This error is due to installation of old eMO client(6.5). Reinstall 
eMO client using the latest version. 
 

11 When submit account is 
tried to perform at node, 
there appears an error---  " 
Run Time error 
2147217900(80040e14) 
Microsoft odbc sql server 
driver(sql server) could not 
find stored procedure. 
Na_get_emo_emo_smsfee" 
then on click, another 
screen appears with run 
time error 440 -- 
automation error. 
 

You are using beta version of Meghdoot 6.5. Uninstall the 
application and install from latest version. 
 

12 CRC Mismatch error in error 
log file  or Unzipping error/  
wrong local header 
signature / So many files are 
pending outside the RXD1 
folder  

Please try the following 
 
1. Stop the emo client application if running. 
2. Open the RXD folder in eMO client installation path. 
3. Select details option in View menu on the top of explorer. 
(View->details). All files will be shown with file type and date 
modified. 
4. Sort the files by modified date (Click on date modified column 
once or twice). 
5. Select and cut the oldest zip file (single file) and copy into to 
separate folder on desktop. (This file might be corrupted). 
6. Start the eMO client application. 
7. Check the eMO after 10-15 minutes. 
Still problem is not solved 
Send the RXD folder to CEPT. 

13 eMO not transmitted from 
Central Server 

The eMOs will be transmitted only if the destination office calls 
the central server. Ask the destination office to call the central 
server. In case of any communication problems at their end they 
can contact CEPT Mysore. 
 
 



14 eMO office name is not 
available in the List of eMO 
Registered Offices. 

Your office might have been deactivated. Please do web 
registration and client registration to activate the same. 

15 eMOs are Received but 
booked eMOs are not 
transmitted and the office 
name is not in registered 
offices list 

If an office is deactivated, during the deactivated period the 
office will receive eMOs but the eMOs booked at the office will 
not be updated at the central server. Please do web registration 
and client registration of the office.  Details refer point number 
3 
 

16 The directory or files could 
not be created... error in 
error log file. / So many files 
are pending outside the 
RXD1 folder 
 

 
The error may be due to lack of space in the installation drive. 
Please do the following 
1. Remove the unwanted files from the drive where emoclient is 
installed. 
2. Move the old files inside RXD1 (which are older than two 
months) to some safe location to other drive or DVD. 
 
Then start the emoclient communication it should solve your 
issues. 
 

17 Administrator Password Lost Forward a backup of the eMO database and a formal request 
(by FAX) in this regard to the Director CEPT Mysore from your 
Divisional Superintendent. 
 

18 Booking option not enable 
in Point of Sale 

Check whether the office PIN code configured in the 
environment option of Supervisor in POS is the same as that 
configured in the eMO package. 
 

19 Not available for redirection 
after printing 

Please check whether redirection is to the same office or to the 
Sub Office. If it is to the same office you can redirect through 
Postman module. If the eMO is for the SO then please check 
whether the Pincode is available in the eMO database. If the 
Pincode is not available, Run eMOOffices and eMOPincodes 
scripts available in latest version. 
 

20 Printed but still showing in 
eMOs not received / not 
printed 

If the eMOs are relating to HO, once returns are taken and 
submit accounts is done in Postman Module then MIS will be 
updated.. 
  
If the eMOs are relating to Sub Office, once u give paid data 
entry, the MIS will be updated. 

21 Account not tallied with 
Pincode 
Example: 
eMO is almost paid and 
entry is paid in eMO 
package and amount is also 
tallied with Sub Account but 
in eMO Supervisor log in it is 
not being verified and also 
amount in Sub Account 

As the messages says " account not tallied for pin code: ......" , it 
means that account is not tallied with subaccount figures. 
Please check the total amount and paid date, SO account date 
and HO account dates both in subaccount and eMO application. 
Also ensure that all the payment offices are mapped correctly 
with subaccount so codes. 
 
Everything is fine still problem is there. Then try using disaster 
recovery.  
 



amount column in eMO 
package is not being shown 
and message comes like this 
" account not tallied for pin 
code: ......"   

 

22 In disaster recovery data 
emos are not shown 

Please forward the items to CEPT, Mysore.,  
 
1. Backup of eMO database. 
2. Copy of TXD, LOG and ERROR LOG folders from eMO client 
folder. 
3. List of PNR numbers which were not updated. 
 

23 Backup of eMO database 
not available  

System Administrators are required to keep latest backup of all 
databases and mdb files. In the case of eMO you have to keep 
copies of RXD and TXD folders also. If you are not following the 
procedure CEPT will not be in a position to give you a solution. 

24 eMO booked with wrong 
Payee Pincode / Remitter 
pincode 

For held up eMOs  option has been provided under Divisional 
Administrator login under Tools-> Change Payee Pincode. 
  
In case of wrong remitter PIN code it can be corrected only by  
the Divisional Administrator of the booking office. 

25 Unexpected EOF or Wrong 
Local Header Signature... in 
Error log folder 

please do the following carefully. 
1. stop the emo client application if running. 
2. Open the data folder which is inside RXD folder in eMO client 
installation path. 
3. Copy the file name alone without extension with file type as 
qsq_tmp . 
4. Then search inside data folder with the file name what you 
have copied with qsq_tmp 
5. You will get two files with same name (one with .qsq and 
another with qsq_tmp). Move the both outside the data folder 
to seperate folder on desktop.( this file might be corrupted). 
6. start the eMO client application. 
7. Check the eMO after 10-15 minutes. 
8. If any emos are shown as not received in emo website  opt for 
request resending . 
 
Still problem is not solved. 
Send the RXD folder for analysis to CEPT. 

26 eMO client error 
CLR error 80004005. The 
program will now terminate. 
 

Either the eMO installation may be corrupted or .net framework 
corrupted. Pl reinstall. 
 

27 Could not resolve Host error Do the following steps to rectify this problem 
1. Go to the folder C:\windows\System32\drivers\etc ( if 
you have installed windows on D partition  then the path will be 
like D:\windows\System32\drivers\etc) 
2. Open the file “Hosts” file using notepad 
3. There will be an entry like the following inside the hosts 
file 
 127.0.0.1       localhost 



  Delete the existing entry which is referred below if it is 
available (if not available do not worry) 
 203.129.241.110    emomsg.ptcmysore.gov.in 
Add one more entry like the following below. 
 
 218.248.43.138    emomsg.ptcmysore.gov.in 

28 Wrong Paid Data Entry The paid information once fed can't be modified at the central 
server. If the eMO is actually not paid, suitable alternate 
arrangement may be made for payment after taking necessary 
precautions against double payment. 

29 In eMO configuration 
unhandled exception - 
access to the path is denied 
is coming. 
 

The error is due to sqlconfig.xml file corruption. Or eMO 
installation may be corrupted. 
Please reinstall the application. 
 

30 error in log file 
 
eMOCommunication-
transmitFile.No connectivity 
:The underlying connection 
was closed: A connection 
that was expected to be 
kept alive was closed by the 
server. 
 

Please check the following points. 
 
1. Check whether the machine is virus infected. Scan it with an 
updated anti-virus package. 
2. open eMOCommunication.exe.config file in eMO 
communication folder (C:\Program Files\eMOClient) if the eMO 
client is installed in C drive. Check whether the fourth line is 
"<add key="server" value="emomsg.ptcmysore.gov.in" />" 
3. Open Config.xml  in eMO communication foldeer (C:\Program 
Files\eMOClient) if the eMO client is installed in C drive.Check 
whether the Thrird line  is 
"<WEBSERVERF>https://services.ptcmysore.gov.in/emo/</WEB
SERVER>" 
4. Check the internet connectivity. 
 
 

31 Unable to upload data error  
in Log file 

This problem is due to connectivity with your sql server. 
Please check whether sql server connectivity is there with the 
client machine, if not solved,please give IP address of the sql 
server in config.xml instead of sql server name . 

32 Time Out error while 
running eMO 
communication 

This problem is due to connectivity with your sql server. 
Please check whether sql server connectivity is there with the 
client machine, if not solved, please give IP address of the sql 
server in config.xml instead of sql server name . 

33 Time and Vista Problem Select Regional and language options in control Panel. Select 
"English(United States)" ->Click on Apply -> Click on "Customize" 
button -> In the Customize Regional Options  and select the 
correct date and time format. 
       
In Windows Vista machine select the Compatibility mode of the 
exe as WindowsXP. (Right Click on the exe, Select properties, 
Check on the "Run this programme in Compatibility mode for " 
and Select Windows X. Click on Apply. 
 

34 Network Error – Unable to 
find enabled Network Card 

Please check the local network connectivity .Ensure that your 
network card is enabled and you could ping with other 



machines in the network from the eMO client machine. 
 

35 Resending of eMOs to HO in 
case of disabling of eMO 

If the eMO is to be resent to the HO, please use Change eMO 
(Transfer of eMOs) option in Divisional admin login. The eMOs 
which were transmitted to the disabled office will be again 
transmitted to the HO. Please take necessary precautions to 
avoid double payment when the SO is enabled subsequently. 

36 Error in error log file “Reset 
Transmission Counter File” 

Send latest emo database backup to CEPT Mysore 
 

37 Error in Configuration file ... 
Root Element is missing 

Please reinstall the eMO client after taking backup of RXD and 
TXD folders. 
 

38 Redirection problem- 
Error in converting varchar 
to Unique identifier… 
 

Please ensure that database is upgraded properly and latest 
version of  eMO application is installed in all the eMO machines. 
Still if problem persist then send eMO database backup. 
 

39 eMO Configuration – error 
Connection could not be 
established. Please retry. 
 

This is only database connection problem. eMO application 
machine is not connecting to eMO database server. Please 
ensure sql server allows remote connections. Set the firewall off 
and open all ports.  
 

40 ‘THIS EMO CANNOT BE 
REDIRECTED’ . error 

 

This error will come in the following circumstances 

1. eMOs are  invoiced to postman and  returns not taken. 
2. Non printed eMOs 

   For such redirection you will have to use missent redirection. 
Please  ascertain these two things. 

 

41  “Not to be Paid” 
clarification 

 

EMO not to be paid will make the eMO not for payment only in 
client system. If the eMO is shown as not paid in MIS and it is 
already paid use disaster recovery module for  paid data 
updation. 

It should be used for emos which are already paid but received 
again due to database crash and subsequent request resending. 

It should not be used otherwise 

 
42 Unhandled exception has 

occurred in a component in 
your application. If you click 
on continue, the application 
will ignore this error and 
attempt to continue. 
 
Access to the path 
‘c:\program files\emo\emo 
\sqlconfig.xml’ is denied. 
 

The error is due to permission problem. Please run as 
administrator. 
 



43 Paid data not updated after 
using disaster recovery 
option, getting message 
‘Account not Tallied’ 
 

In cases where message ‘Account not tallied ‘ is got for a 
particular PNR number, efforts should be made tallying with 
Cash Book and Sub Accounts. If it is not possible, the supervisor 
can give reason for non tallying in the remarks column. 
Thereafter the paid data will be updated. 
 

44 "CANNOT OPEN DATABASE 
REQUESTED LOGIN 
SUBACCOUNTS LOGIN FAILS. 
LOGIN FAILS FOR USER 
SUBTREASURY PA" 
 

If subaccount database is not available you can ignore the error 
account will be tallied only with treasury. 
 

45 BULK PAYEE EMOS 
REDIRECTION 
 

Bulk payee eMOs cannot be redirected. It can only returned to 
sender automatically if refused by bulk payee. 
 

46 NOT AN EMO ENABLED 
OFFICE 

Please run emooffices exl  from latest Version.  

47 Eurogiro Country issues First you should upgrade to Megh 6.6 service packs (latest) if 
you have not upgraded earlier in month of April 2010. 
Then you have to run the emo.exl file available in country 
problem folder available in this link 
ftp://ftp.ptcinfo.org/Meghdootv6.6/Utilities/PointOfSale/eurogi
roCountryProblem/ 
 
Once that is executed successfully, you have to copy the 
message files from ftp link given above (newmessages.zip after 
unzipping) into data folder available inside RXD folder of the 
emoclient. 
If you have not changed emoclient exe before in April 2010 
please change that exe to latest. 
Then run the emoclient it will update. Please check this step and 
try. 

48 MIS figure does not tally 
/appear 

Check whether your office appears in registered list.  If not 
please register. Registered but figure not tallied. 
 
Please forward the following items to CEPT, Mysore.  
1. Latest Backup of eMO database. 
2. Latest Copy of TXD, LOG and ERROR LOG folders from eMO 
client folder. 
 

49 Pincode changes/ 
upgradation  of offices 
/downgradation 

Please send a fax to CEPT through your divisional head with 
correct status of the office and the pincode to avoid eMo not 
transmitted problems later. 

50 Problem in broadband / 
internet issues. 

Disable the office immediately and issue request resending of 
emos in divisional admin login and wait for a day. The emos are 
supposed to be transmitted to HO / Account office. Still not 
received send a mail to CEPT with the office details and emo 
particulars. 
In the case of HO no other option is there so the office should 
be enabled at the earliest after setting right the issue. 

51 Request resending  It is available in divisional admin login of emo web page. It is 

ftp://ftp.ptcinfo.org/Meghdootv6.6/Utilities/PointOfSale/eurogiroCountryProblem/
ftp://ftp.ptcinfo.org/Meghdootv6.6/Utilities/PointOfSale/eurogiroCountryProblem/


used for eMos not received / not printed only 

52 Disaster Request for data It is available in Supervisor login of emo software. It should be 
used when eMOs are paid actually but shown as not paid in emo 
web page. 
 

53 Disaster Redirection 
problem    

This option should be used when eMos are received, printed 
and invoiced to postman. Then database crashed. The postman 
brings the emo returns with  remarks redirection. In such cases 
only this option works.   
 
Regular redirection should be done through redirection / 
Remarks entry option in Postman /eMO software 

54 Disaster Paid entry done but 
not updated in web page as 
paid. 

Check the following- 
 whether paid entry is done properly and  it is authorised  
If those things are done still not updated please send  
1. Latest Backup of eMO database. 
2. Latest Copy of TXD, LOG and ERROR LOG folders from eMO 
client folder. 
 

55 Emos not received/ not 
printed/ not paid updation 
in central server 

Please forward the log and error log folders & TXD folder for 
analysis to CEPT, Mysore. 
 

 
 
 


